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ABOUT THE SAMPLES 

This quick start guide comes with a few sample card templates to give you ideas or demonstrate 
how certain tasks can be easily implemented. 

These examples are installed in the Samples sub-folder of the folder where you unzipped this 
guide. 

These different card templates require a Professional or Expert edition to be fully functional 
(except for "Masking," which works regardless of the edition). 

If you only have a Standard edition, or if you haven't yet activated your license, you can still test 
these templates BUT you won't be able to print them correctly. To do this, activate the demo 
mode from the "Help" menu (remember to deactivate this mode once you've tested these 
templates). 

TEMPLATE USED IN THIS GUIDE 
This template is the result of all the demonstrations and exercises in this guide. The file is named 
Utopia RC.eccs. 

This is a sports club membership card, with each card displaying: 

• The cardholder's first and last names,  

• Their photograph,  

• Their status (manager, coach, supporter, or player),  

• A barcode identifying the card,  

• The card's print date,  

• The card's expiration date.  

 

Club member information is stored in a Microsoft Excel™ spreadsheet so you can easily access 
this data. 

This spreadsheet is located in the Utopia RC.xlsx file located in the same folder as the card 
template. 
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CONCATENATION 
This template shows how to concatenate (join together) two pieces of information. It's particularly 
useful when, for example, you have a database containing a first name field and a last name field, 
and you want to display them all in a single object. 

The file is named Concatenation.eccs 

 

The input window allows you to enter first and last names independently. 

The text object with the orange background performs the concatenation using a simple formula. 

The object with the yellow background performs the same concatenation, with some 
improvements, using a script. 

Switch to design mode to view the properties of these two objects and see the formula/script that 
defines their contents. Note the off-card fields that allow input. 

MASKING 
This template shows how to partially mask an image by positioning it behind another. The file is 
named Cudly Dogs.eccs 
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Each printed card is a profile of a dog available for adoption from a shelter. It contains the dog's 
name, age, breed, photograph, a description, and authentication information. 

In this template, the photograph must be enclosed within a circle. To avoid having to rework all 
the dog photos, the circle is actually a transparent part of another graphic object placed over a 
square or rectangular photograph. 

To achieve this effect, the background image found in Images/Cudly Dogs.png contains a 
transparent circle. This image has been placed inside an Image object named Background, which 
is itself placed over another image object named Picture. 

Tip: You can even move the photograph slightly. Right-click on the background near the 
photograph until the "Select" command appears in the context menu. Choose "Picture" from the 
submenu, then, while holding down the SHIFT key, move the photo to center it. 

ADAPTIVE BACKGROUND & ICONS, VERSION 1 
This complex template uses a script to layout the card background image and three formulas for 
the three icons at the bottom of the map. The file is named Festival v1.eccs. 

This is a festival pass. Each cardholder is identified by a role (visitor, VIP, musician, reception staff, 
or technician), their first and last name, and access permissions to amenities: reserved parking, 
backstage access, and access to the staff cafeteria. 

The organizer wanted each card to be colored differently depending on the visitor's status: brown 
for visitors, purple for musicians, green for VIPs, blue for reception staff, and black for technicians. 

In addition, the access permissions to amenities must be presented as icons on the card. 

And of course, entering this information must be simplified so that the team responsible for 
creating the cards can do so without any IT knowledge. 

 

The script retrieves the selection made in the "Card Type" drop-down list and applies the 
appropriate image to the card background, based on that selection. 
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The formulas are almost identical: they retrieve the value from the "Access to..." drop-down list, 
and if this value is "Yes", the function returns the name of the icon file; otherwise, an empty file 
name. This file name is then injected into the corresponding icon object. 

ADAPTIVE BACKGROUND & ICONS, VERSION 2 
This complex template uses a script to layout the map background image and icons. The file is 
named Festival v2.eccs. 

Version 1 is a good start, but it's necessary to define permissions for each card, although it would 
be possible to automate this process because permissions can be automatically granted 
depending on the holder's role. For example, a musician or technician must have permission to 
access the backstage. 

Furthermore, permissions should be able to be manually adjusted in certain specific cases. 

Finally, it would be nice if there were no gaps in the row of icons so that they would be 
automatically aligned to the right. 

 

In this version, the script is improved so that depending on the selected role, the permissions are 
automatically defined, then modulated according to the choices made in the three "Access to…" 
drop-down lists. Finally, the script dynamically positions the icons starting from the right and 
displays or hides them. 

QR-CODE 
This simple template uses a formula to generate a QR code based on the information entered in 
the input window. The file is named Wifi.eccs 

The cards generated allow guests to connect to a hotel's Wi-Fi by displaying a QR code that they 
can scan with their mobile phone to immediately access the Wi-Fi. 

Connection information is also displayed at the bottom of the card so guests can enter it into 
devices that don't have QR code recognition (e.g., laptops). 
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This template mainly consists of two text objects whose values must be entered in the input 
window on the right, and a formula in the QR-Code object that generates the text string necessary 
for the phone to understand that this code contains connection information to a Wifi network. 
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DESIGNING A CARD TEMPLATE 

Let's start the software and review the first basic knowledge. In this chapter, we'll introduce the 
design mode and the operating mode, and we will print out our first cards. 

LAUNCHING EMEDIA CS2 
To start the application, we may either use the icon created on the desktop by the installation 
program or use the shortcut in the Windows "Start" menu, or double-click on a card template file 
(.eccs extension). 

Upon loading, a splash screen appears, followed by the "Open template" window if you started 
the application from the shortcuts. 

This window displays the last used 
templates with useful additional 
information: 

•  Preview 

•  Title 

•  Times opened 

•  Last used date 

•  Template path 

•  Connected to a database (or not
connected) 

•  Simple or double sided 

•  Favorite 

The bottom right buttons sort the list. 

The bottom left button and link allows 
you to open a template file on disk, using 
the standard "Open file" dialog box. 

The star on the right of a template shows a favorite template that will always be shown on the top 
of the list. Click on this star to set or unset the favorite status of a template. 

Create a card template 
When the application is launched, the active mode is the operating mode. We have to switch to 
the design mode to create our own template. 

The operating mode allows the 
printout of the cards. In this mode, 
the template is displayed as it will 
be printed out, with all the objects 
created in design mode. 

The design mode allows us to 
create or modify the template. 

The switch located here allows 
us to change from the two 
modes. 

 

 

 

First launch of eMedia CS2 in operating mode 
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THE ELEMENTS DISPLAYED IN DESIGN MODE 
The application main window contains the common elements you may find in any application: 
title bar and menu bar at the top, status bar at the bottom with some useful information. The 
window also contains four specific elements: the card template, the toolbox, the layers panel and 
the properties panel. 

The card template 

It occupies the central part of the window, and should be empty at this moment. We'll add in this 
template a background picture and the objects to print out. The tabs above the template allow 
switching between the sides of the card. 

To create a double-sided card or 
change the orientation of the current 
side, or to change the dimensions of 
the card, use the "Card" menu: 

 

These options are not definitive, you'll be able to change them as any time. 

From the "View" menu or using the F8 function key, you can change the preview zoom level. 

The grid in the background of the card helps you to place the objects and may be setup from the 
properties pane or from the "View" menu. 

The toolbox (upper left side) 

On the left side of the window, a vertical panel contains all the objects 
that can be added to the card during design: texts, barcodes, 
QR-Codes, images & photos, clipart, signature, geometric shapes and 
programming of the magnetic stripe, chip and contactless chip. 

A tooltip describing the purpose of one of the icons is displayed when 
you place the mouse over it. 

The layers panel (lower left side) 

The graphic layers are like stacked sheets of transparent glass. Each 
sheet contains an object. You can see the layers below through the 
transparent areas of the above layers. You can move each of these 
layers relative to the others to reveal or hide its contents, either 
completely or partially. 

 
Graphical layers 

Additionally, you can adjust the opacity level of each layer to make its 
content more or less transparent. 

The Layers window lists all the layers on the current side of the card. 
You can show or hide layers, and you can move each layer up or 
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down on the card using the mouse. You can lock a layer to prevent it from being moved by 
mistake. Other commands and options are available from the properties of each object. 

The properties panel (right side) 

On the right side of the window, the Properties panel 
displays all the characteristics of the selected object 
and, if no object is selected, the card background 
properties. 

These properties are specific to each object type, so the 
contents of this window changes each time you click on 
an object on the card. To deselect an object, simply click 
on the background of the window, in a location where 
no object is present. 

The properties panel contains the selected object and 
an indication at the top. Here, the card side properties. 

Below is a list of categorized characteristics with each 
property's respective value. 

To change the value of a property, simply enter the 
desired value, click the radio button or checkbox, or 
click the button to the right of the property to select the 
desired value from a drop-down list. 

This guide is not intended to explain all the properties 
of all objects. We will only explain some of the most 
commonly used properties. 

We remind you that online help is accessible at any  
time by pressing the F1 key on the keyboard. 

THE CARD INFORMATION 
Our card has properties that we can set at any time. The most important are the orientation, the 
default printer, and the background. 

The card orientation 
All new cards are oriented "landscape" by default, printing across 
the width. If you want to print across the height, check the 
"Portrait" box. 

The default printer 
eMedia CS remembers a default printer independent of the choice you made in Windows settings, 
as the card printer may not be the best choice for printing your Microsoft Word™ or Microsoft 
Excel™ documents. 

In addition to this separate default printer, eMedia CS remembers 
the printer to use for each card template. To specify this printer, 
open the drop-down list in the "Default Printer" category and select yours. From then on, the user 
in production mode can use the print buttons to edit cards based on this template on this printer. 

Our card background 
Now a little practice: our card is empty, so let's insert a background. 

Click on the card background to make sure the properties panel 
displays the characteristics of the card. Select then the "Picture 
store" property in the "Background" category and select "Picture 
stored on disk or on the internet". 
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Next, select the "Image" property and choose the image source: disk file, internet image, 
immediate image acquisition with the acquisition device defined in the application settings or the 
source if the device is Twain or WIA. 

Select "Select an image from disk." The standard file open dialog box 
appears. Navigate through your disks and folders to find the 
appropriate background image for your template. The image appears 
as the background image, and its disk path is entered in the "Image" 
property. 

 

By selecting "Select an image from the Internet," eMedia CS2 will prompt you to enter a full URL to 
the image file. 

Since the "Storage" property is set to "File on disk or the Internet," eMedia CS2 will search for the 
image each time the template is opened, whether on disk or the Internet. The image file is 
considered as dynamically linked. 

If you want the image to be statically linked and included in the card template, change the 
"Storage" property to "Card Template". The link to the original file will be broken, and the image 
will be available even on another PC or a PC without internet access. 

The background of the card 
is now defined 

This is image is based on a picture 
© 2018 Edgar Pimenta on Unsplash.com 

THE IDENTITY PICTURE OF THE CARD HOLDER 
Now let's add the cardholder's photo ID. We can use the "image" object from the toolbox for this 
purpose. 

An image may be a fixed object, such as a logo or illustration that will be 
unchanged from one printed card to another, or may be a variable object, 
such as an ID photo that must be different from one card to another and can 
be changed in operation mode by allowing the user to select a disk file or to 
perform an acquisition from a scanner, a digital camera or a webcam. 

Note that eMedia CS2 assumes the background image should cover the entire card. For best 
printing results, your image should be sized appropriately. For example, for a CR80 card on a 
300 dpi printer, the image should be approximately 1011 x 649 pixels. 
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A default image appears in the top left corner of the card. It is surrounded by handles (blue 
squares) that you can grab with the mouse to resize the object: click on the handle, hold down the 
mouse button, and drag it to the desired size. 

To move the object, place the mouse over it, left-click, hold down the mouse button, and drag the 
mouse to the desired position. 

 

The Properties panel displays the characteristics of this image. You will notice among these 
properties: 

Object Name 

Object Name allows you to name the selected object so you can 
identify it in the Layers panel or reference it in a formula or script. 

An object name must begin with a letter and must contain only letters, numbers, and 
underscores. For example, the newly created object could be named "IdPicture". 
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Image Type 

Image Type indicates whether the object is intended to contain a 
fixed image, which remains the same from one card to the next, or a 
photograph or signature, which vary from one card to the next. 

The difference between "Picture" and "Signature" lies in the way the image is acquired in 
operating mode. Two separate settings are available in the application's configuration to define 
the photo acquisition device and the signature acquisition device. 

Picture store and Picture 

These two properties have the same role as those described for the background of the card. 
"Storage" defines where the image is located, while "Image" contains the image file name or 
storage specification in the card template. 

Regarding image storage, if the card template is linked to a database, two additional options will 
be offered: in a database field as an image file name, and in a database field in binary format. You 
will then have to enter the name of the corresponding field in the "Database Field" property. 

Position 

The five properties here define the object's position on the map, its 
width and height, and the type of ribbon to use when printing.  

The dimensions are expressed in millimeters from the top left corner 
of the card. 

Here the object is located at 6 mm from the left side, at 22 mm from the top and its dimension is 
20 mm x 26 mm. 

Aspect 

By default, image objects are automatically zoomed, allowing you to center them within the 
object's boundaries, if necessary by cropping the right and left sides of the original image (or the 
top and bottom). 

You can switch to manual zoom and set the magnification level and 
cropping yourself. However, be careful with photos and signatures: 
switching to manual zoom will apply to all printed cards, and it's your 
responsibility to only use images of similar dimensions to ensure 
optimal results. 

Opacity allows you to set the transparency level for the object. At 100%, the object will be fully 
visible; at 0%, it will be hidden. Between these two extremes, what's beneath the object will show 
through. 

Rotation allows you to vary the angle of the object relative to the vertical so that it is printed 
sideways, upside down, or at any angle you like. 

Background 

Transparent areas of the object can be colored. With these two 
properties, you can select the background color and the opacity of 
this background. 

Border 

 You can frame the object with a border. Type allows you to select 
the border type, Width allows you to specify the thickness of this 
border in points, Color allows you to choose the color, and Opacity 
selects the saturation level. 



eMe

All r
  

edia CS – Quick S

rights reserved 

Caption

When th
the card
guide. W
data corr
in the Pro

Text is a
informat

Order in
thus defi
even tho
template

Tooltip w
input are
be entere

For insta

In this fir
the input

In the fo
for the o

Start Guide 

n 

is card templ
s won't nece

We will provide
rectly. For thi
operties pane

a very short 
ion should be

dicates the p
ine that the 

ough the obje
e. The first-ord

will be display
ea. He will thu
ed in this loca

nce, here are

rst window, th
t is not so eas

llowing one, 
bjects, the inp

late is define
essarily have 
e them with 
s purpose, th
e: 

label that w
e entered. 

position of th
last name m
ects will hav
der object wil

yed as a toolt
us be able to
ation. 

e two input wi

he Text, Orde
sy: 

the Text, Ord
put is easy. N

d, the person
the skills yo

information 
hree propertie

will appear in

e input area 
ust be entere
e been creat
l be the first 

tip and in the
o have inform

indows for th

er and Toolti

der and Tool
otice the help

n in charge of
ou will have 
so they can e
es have been

n the input w

among all th
ed first, then
ted in a diffe
presented in 

e status bar w
mation concer

e same card.

p properties 

tip propertie
p text under t

f printing 
with this 
enter the 
 included 

window next

hose defined 
n the first nam
erent order d
the input win

when the use
rning the natu

 

have not bee

es have been 
the input box

© 1999
228 rue de 

t to the area

in the templa
me, then the 
during the de
ndow. 

r places the c
ure of the inf

en defined fo

set by the ca
xes: 

9 - 2025 Mediaso
la Convention – 

a where the 

ate. You can 
e photo, etc., 
esign of the 

cursor in the 
formation to 

r any object, 

 

ard designer 

 

-

oft Development
75015 Paris – Fra

- 21 - 

t SAS 
ance 

3



- 22 - eMedia CS – Quick Start Guide 

© 1999 - 2025 Mediasoft Development SAS All rights reserved 
 228 rue de la Convention – 75015 Paris – France 

3 

Display and Print Options 

These options allow for some comfort when designing the card: 

Object is visible on the card is enabled by default. If disabled, the 
object will not appear on the printed card. This can be useful for 
objects that need to be used as calculation intermediaries in 
formulas and scripts. 

Object is hidden in Design mode is disabled by default. If enabled, the object disappears in 
Design mode, which can be useful for making space. It will be visible in Operating mode, of 
course. To make this object visible again in Design mode, click on it in the Layers panel and 
uncheck the property. 

Object is locked in Design mode is disabled by default and the object can be moved or resized. 
When enabled, the object can no longer be moved or resized (useful to avoid errors). 

THE HOLDER'S NAME AND OTHER TEXTS 
Let's add some information to our card template, such as the cardholder's name. To do this, we'll 
add a text object and then set its properties so that it can display the information as we want.  

In the toolbox on the left, click "Text Object." It appears in the top left corner of the 
current template. Note that for double-sided cards, the object appears on the 
currently selected side. To ensure that the creation is done on the correct side, click 
first on the tab for the side where you want to create the object before clicking in 
the toolbox icon. The display then looks like: 

 

The Properties panel allows you to specify the characteristics of this object. We won't revisit the 
properties already discussed in the previous paragraph; they have similar roles across object 
types. 

Remember to start by naming the object using the first property: Object Name. This good habit 
will save you a lot of time later. 

Source allows you to define the origin of the information contained 
in the object. This can be one of the values defined below. 

Data in this object defines the default information displayed in operating mode. Depending on 
the chosen source, this property can appear as a simple input field or a drop-down list. 

If the chosen source is "fixed data", indicating that it is a static, non-modifiable object, this 
property displays the value presented in the object. 

If the chosen source indicates a variable value, the user in operating mode will see the updated 
data, such as the contents of a database field, the result of a calculation, etc. 
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The data sources 
Multiple sources are possible; however, an object can only have one source at a time. For 
instance, it is impossible to have an object containing the result of a calculation performed against 
a database field. 

While it is not possible to combine two data sources, you may, however, in the Professional and 
Expert editions of the software, create calculation formulas to achieve this functionality: create 
first an invisible object displaying the content of a database field, then a second visible object 
performing the calculation on the value displayed by the first one. 

Possible data sources include: 

• Fixed data indicates that the content of the object is fixed and cannot be 
changed by the user in operating mode. The "Data in this object" 
property contains the information to be displayed. 

• User Input specifies that the text will be entered by the user in operating 
mode, from a text box located in an input window. The property "Data in this object" contains 
the default value. 

• Print counter indicates that the object contains a numeric value. This value is automatically 
changed each time the card is printed. This allows, for example, numbering the cards. You can 
define the first value and the added value for each print in the dialog box displayed from the 
"Print counter" command in the "Tools" menu. The "Data in this object" property is not used. 

• Date and Time causes the date and/or time of the map printout to be printed. The "Data in 
this object" property is not used. 

• Formula specifies that the object contains a formula, which is recalculated each time data is 
entered by the user, or print time. The result of this calculation is displayed in the object. The 
"Data in this object" property contains the calculation formula to be evaluated. 

• Database field specifies that the object should display the value of a database field linked to 
the card template. The "Data in this object" property should contain the name of the database 
field. 

• Choices list allows the user in operating mode to select a choice from a list of possible values. 
The "Data in this object" property allows you to specify the list of proposed values. 

• Database choice is a little more complex: this source tells the software that the user will be 
able to select a value from a set of possibilities. This set is extracted from a second table in the 
database. Once the value is selected, this one or the contents of another field in the table will 
be automatically stored in a field of the main table. 

• Script indicates that the value displayed by the object is the result of executing a function 
written in VBScript. 

Note however that while simple sources are usable in 
all editions of the software, others require a 
Professional or Expert edition of the application. 

Additionally, the "Formula" and "Script" sources 
require some programming skills. 

While the "Formula" source is quite similar to the 
calculation formulas in your favorite spreadsheet, the 
"Script" source requires a good knowledge of the 
VBScript programming language. 

The "Database choice" source, for its part, requires a 
minimum of knowledge in relational databases. 

These concepts are outside the scope of this guide, 
which must remain accessible to all. 

Professional or Expert Editions 
Demonstration mode 

Trial & Standard Editions  

Fixed data   
 User input   
Print counter   
Date and time   
Formula   
Database field   
Choices list   
Database choice   
Script  
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The cardholder's name 
We want the card to display the cardholder's name to ensure their identity. 

Since this information will be specific to each cardholder, and therefore to each printed card, we'll 
use a variable data source so that the user in production mode can enter the identity before 
printing. 

We'll therefore define the property values: 

• Object Name to name it, 

• Select as Source: "User Input", 

• Enter in Data in this object a default value, 

• Provide help with the properties in the Caption category. 

Let's then place the text in its final position and make some aesthetic adjustments to maximize its 
visibility (text color white and black background with 50% opacity): 

 

Let's review the available properties not already covered in this document for this text object: 

• Font allows you to define the font and its characteristics (size, 
bold, italics, etc.).  

• Format will be discussed below.  

• Automatic resizing to fit specifies that the font size can be automatically adjusted so that the 
entire text is displayed, either by reducing the font size if there is a lot of text, or by enlarging it 
otherwise. 

• Word wrap enabled allows you to specify that the text can be written on multiple lines, as by 
default text objects are only displayed on a single line. This allows you to place long texts on 
the card, such as instructions for returning the card in case of loss. 

Data format 

The Format property allows you to define an 
automatic layout mask, which is very useful for 
numeric values, dates, and text. In operating 
mode, the user enters the information as needed, 
and eMedia CS2 adapts the data presentation 
according to your specifications.  

To specify a format, click the button to the right of 
the property. In the dialog box that appears, select 
the desired category and then select the desired 
format from the central list. 
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We could be perfectionists and manually enter the exact values for Top, Left, Width and Height, 
by entering them in millimeters. Note that these values indicate the position of the upper left 
corner of the object IF IT WERE ORIENTED AT 0°. 

The properties of the Caption category are useless in our case because as the source of the object 
implies an automatic calculation, no information will be requested from the user in exploitation 
mode. We don't set them. 

Let's go a little further 
With a Professional or Expert edition of eMedia CS2, we can use more powerful features such as 
formulas and scripts, as well as advanced database functions. We'll come back to databases a 
little later in this guide. 

 

Let's add the card's expiration date to our template. Located below the photo and preceded by 
the text "Expires on", it will perform a calculation based on a validity start date requested from the 
user, with an offset of one year minus one day in the future. 

An object for entering the start date 

Let's start by adding a text object named "Start_Date" that will be used to ask the user for the 
card's start date in exploitation mode. Let's configure this object as follows (in this screenshot, the 
unnecessary property categories have been hidden; simply click on the title to do so): 

 

 

• Object Name is set to "Start_date". 

• Source contains "User Input" since the user will need to enter the value.  

• Default data is set to today's date, this will be the default value. 

• Background is set to white color and 50% opacity for better visibility. 

• The three properties in the Legend category provide assistance to the user. 

Note that you can test these advanced features with a Trial or Standard edition of eMedia CS2 
by activating the demonstration mode from the "Help" menu. In this special mode, the 
software behaves like an Expert edition, but is unable to print cards correctly. An unsightly 
label is affixed to each card. 

Note that it is possible to simplify the interface by hiding certain property categories just by 
clicking on the category title. In the screenshot above, we have closed the Text, Aspect and 
Border categories. 
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Furthermore, to prevent the user-entered value from appearing on the printed card, we position 
this object outside the card, because yes, this is allowed and even recommended for objects 
created for intermediate input or calculations. 

Another object for calculation and printing 

Now let's place another text object, which will be positioned on the card and thus printed. Let's 
assign properties to it so that its presentation is appropriate: 

• Object Name is set to "End_date". 

• Source contain is set to "Formula" to allow an automatic calculation. 

• Formula contains the formula (see below). 

• The Text & Apect categories are set to better visibility (color: white, smaller font size). 

• The Caption category is useless as nothing will be asked to the user. The calculation is 
performed automatically. 

 

Finally, let's enter the 
calculation formula using 
the Formula Wizard, which 
appears when you click the 
button to the right of the 
Formula property. 

This wizard assists in 
formula entry by displaying 
the text of the calculation 
formula, topped with two 
lists: 

The left list contains all the 
card objects and database 
fields (see below). 

The right list contains all the 
functions that can be used 
to create your formula. 
These functions perform similar functions to those found in Microsoft Excel™, for example, and 
can be combined. 
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The "Check" button below the formula allows you to verify the correct syntax of the entered 
formula and displays the result of the evaluation, or reports any errors encountered. 

Enter the following calculation formula: 

"Expires on " & Format(DateAdd("yyyy", 1, DateValue(@Start_date)) – 1, "mmmm d,yyyy") 

Let's explain this formula: First, as in Microsoft Excel™, the evaluation is done from the inside out: 
What's in parentheses is calculated first. Calculation functions, much like the SUM function in 
Microsoft Excel™, must be followed by parameters in parentheses and separated by commas. 

"Expires on " & Format(DateAdd("yyyy", 1, DateValue(@Start_date)) – 1, "mmmm d,yyyy") 

The "@" symbol indicates that the adjacent word is the name of an object on the card, and that 
the evaluation should return the value displayed by that object. 

"Expires on " & Format(DateAdd("yyyy", 1, DateValue(@Start_date)) – 1, "mmmm d,yyyy") 

The DateValue function requires a parameter, and its role is to transform the value of the 
parameter into an acceptable date to the computer (i.e. a number of days since 01/01/1900), 
regardless of how the date was formatted, here in the "Start_Date" object. 

"Expires on " & Format(DateAdd("yyyy", 1, DateValue(@Start_date)) – 1, "mmmm d,yyyy") 

DateAdd is a function that allows to add a certain number of intervals to a date: days, weeks, 
months, years, etc. The first parameter indicates the type of interval to add ("yyyy" = years), the 
second parameter indicates the number of intervals (here 1 interval, i.e., one year). The third 
parameter indicates the date to which this interval should be added. 

At this stage of the calculation, the formula evaluation indicates that the value of the "Start_Date" 
object must be read, considered as a date, then one year must be added to this date. 

"Expires on " & Format(DateAdd("yyyy", 1, DateValue(@Start_date)) – 1, "mmmm d,yyyy") 

Subtracting 1 from the calculated date gives the previous day's date, since dates and times are 
considered as numbers of days since 01/01/1900. So, if the date displayed by the "Start_Date" 
object is January 1, 2030, adding one year gives January 1, 2031, subtracting one day gives the 
expected result: the card will be valid from 01/01/2030 to 12/31/2030. 

"Expires on " & Format(DateAdd("yyyy", 1, DateValue(@Start_date)) – 1, "mmmm d,yyyy") 

The Format function has exactly the same role as the Format property of objects. It allows you to 
present information by applying formatting. The function requires two parameters: the first one is 
the value to be formatted, and the second one is the format to be applied. The available formats 
are the same as those for the Format property. 

With the expression in green above, the calculated date at 1 year – 1 day will be returned by the 
function as text in month day year format. 

"Expires on " & Format(DateAdd("yyyy", 1, DateValue(@Start_date)) – 1, "mmmm d,yyyy") 

The "&" symbol is an operator, like the well-known arithmetic operators +, -, /, and *. This 
operator allows the evaluator to concatenate (i.e., join) two texts together. 

The final formula will therefore return the text "Expires on December 31, 2025" if the user entered 
01/01/2025 in the "Start_Date" object: 
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A CHOICE LIST 
For our card, we want the user to be able to select information from a set of possible values. 

Not only will this be easier for the user, but it will also prevent typos. 

Let's create a text object, name it, and display it as this one: 

• This object is called "Category", 

• It is written in yellow on a 50% black background,  

• It is vertically aligned "top", 

• We've sized it to encompass the passport photo and overflow slightly 
to give the photo a framed effect.  

Problem: Our object is over the identity picture. Let's move it in 
the Graphics Layers window to place it under the photography. 

To do this, in the Graphics Layers window, place the mouse over 
the two arrows to the right of the object, click and hold, then 
move the object just below the "IdPicture" object before 
releasing the mouse: 

 

Now the category is located under the 
Identity picture, the black background 
of the "Category" object doesn't 
obscure the picture. 

Now let's set the Source property to "Choice List" to indicate that the 
user in operating mode will have to choose a value from a 
predefined list, and then click the button to the right of the Choice 
box to bring up the input window: 

This window allows you to enter the possible choices. They are displayed in the list on the left. 

To add a choice, enter its value in the input field above 
the list, then click the "+" button. 

To delete a choice, click on it in the list, then click the "X" 
button. 

To reorder the choices, select the one to move in the list 
on the left, then use the arrow buttons. 

Finally, to set the default choice, the one displayed if no 
choice is selected, check the box next to it. 

Click OK once your list of possibilities is created. 

The user may now select the correct answer by clicking 
the button at the end of the input field, then choose the 
appropriate value from the list. 

He may also click on "< Close >" to close the list without 
changing the previous or default selection. 
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THE MAGNETIC STRIPE 
The magnetic stripe on the back of the card (front for Japanese cards) is considered a series of 
three objects whose Source properties are formulas. 

A wizard is available to help you create the encoding formula(s). 

To specify the contents of the magnetic stripe, click the corresponding button in the 
toolbox on the left. 

The "Magnetic Encoding" window appears: 

 

The radio buttons at the top allow you to select the type of encoding to perform: 

• ISO: The encoding complies with ISO standards; eMedia CS2 verifies the data to be encoded. 

• Non ISO: The encoding does not comply with ISO standards; eMedia CS2 does not verify the 
data to be encoded. 

• JIS Type II: The encoding complies with the Japanese JIS Type II standard. 

The three input fields allow you to enter the three formulas (one for each track) or the formula on 
a single track on the front of the card if the "JIS Type II" standard has been selected. 

A help text below each field indicates the maximum dimension accepted by the track, as well as 
the permitted data type. You will notice that with non ISO encoding, the formula can return any 
number of arbitrary characters since eMedia CS2 does not verify the validity of what is to be sent 
to the encoder. 

When encoding the card, eMedia CS2 sends the result of the formula evaluation to the encoder, 
replacing prohibited characters with spaces for ISO track 1 and eliminating prohibited characters 
for ISO tracks 2 and 3. 

The buttons at the end of the field allow you to: 

 Opens the "Formula Editor" window seen previously, in order to enter a formula and test it. 

 Opens a specialized wizard that allows you to build the track content step by step. At each 
step, you will indicate whether you want to add or concatenate map objects, database fields, 
fixed data, etc. 

Now let's use this button to call the 
Magnetic Stripe Wizard: 

On the home page, read the 
instructions displayed and then click on 
the "Next" button to begin composing 
the contents of the magnetic strip. 
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This screen serves as a pivot. Each time 
an element is modified or added to the 
track, we are returned back to this 
display with the updated content in the 
left list. 

Note the presence at the bottom of the 
window of a preview showing the data as 
it will be encoded on the track. 

To add an element, just click "Add" 

To modify, delete, or change the position 
of an element (move to the previous or 
next location on the track), select it in the 
list and then click the needed command 
button below. 

Let's start by adding data to encode. Click the "Add" button: 

This screen allows you to select the type 
of information to add to the track. 

It can be: 

• A spacing,  

• The standard separator for the track,  

• The content of an object already 
present on the card,  

• The content of a database field (see 
below),  

• A fixed data item,  

• The answer to a question that will be 
asked at print time,  

• The result of a calculation. 

We want the content of the magnetic stripe to begin with the card number. So, let's select "The 
content of an object on the card" and click "Next": 

The list of objects on the card appears. 

Here we can clearly see the importance 
of naming the objects. Imagine this list 
containing "Text1", "Text2", "Text3", etc. 

Let's click on the "CardNumber" object, 
which is the barcode containing the card 
number. 

Then let's click "Next". 

Note that once a magnetic stripe has been set up, it is shown on the back side of the template 
(ISO and Non ISO cards) or on the front side of the template (JIS Type II cards) to help you not 
to add any object at the same location.
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Each addition made to the magnetic 
stripe is an object, like those on the card. 
You can therefore: 

• Give it a name (for possible reuse), 

• Define a formatting, 

• Define whether the object should 
have a variable, fixed, or maximum 
length, 

• Indicate the fixed or maximum 
dimension in terms of the number of 
characters, 

• Specify the alignment (by adding 
spaces to the left or right in the case of a 
fixed dimension). 

Let's call this first object "Number" with a maximum length of 12 characters, then click "Next": 

We return to the main page to move on 
to the second object or to finish. 

Note that at the bottom of the window, 
the preview area begins to display an 
encoding example based on the 
currently known data. 

For now, only a zero appears there 
because the "CardNumber" object is 
currently unknown. 

We have never printed it, and the 
object's formatting will only be taken into 
account in operating mode). 

Let's continue. We will now add a track separator. For track number 1, this standard separator is 
the "^" character: 

The procedure is identical to the one 
above: 

1. Click "Add", 

2. Select "The track Separator" and click 
"Next", 

3. Name it "Separator1", no format, the 
length information is not editable, click 
"Next". 

The result is shown here. 

Exercise 

Continue the process to add the holder's last name (up to 12 characters), a separator, and the 
holder's first name (up to 10 characters) to the track: 

The final window should look like this: 
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Stuck? Let's go step by step: 

Let's start by adding the cardholder's name: In operating mode, the cardholder's name is 
located in the "LastName" object. We'll reuse the value of this object: Click "Add", select "The 
contents of an object on the card", select "LastName", and then enter the following size 
information: "less than 12 characters". 

Let's add a separator: We proceed exactly as before: Add, track separator, name it "Separator2". 

Let's add the first name: Click "Add", select "The contents of an object on the card", select 
"FirstName", and then enter the following size information: "less than 10 characters". 

Real-time magnetic stripe preview 
In operating mode, when filling a card, you can view the contents of the magnetic stripe using the 
"Print preview..." command in the "File" menu: 

 

Select "Magnetic stripe, track 1", "Magnetic stripe, track 2", or "Magnetic stripe, track 3" from the 
drop-down list, and the value ready to be encoded on the magnetic stripe will be displayed below. 

In the example above, we see the card number, the track separator "^", the first 12 characters of 
the last name (in uppercase as the magnetic stripe doesn't support lowercase letters), the 
separator, and the first name. 
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Please note also that ISO Standard for magnetic stripe doesn't also support accented letters, so 
eMedia CS2 will comply to the standard by replacing accented letters with spaces. 

CONNECTING TO A DATABASE 
All the editions of eMedia CS2 support access to data stored in a database. 

The Starter and Standard editions only support Microsoft Excel™ datasheets. However, note that 
Microsoft Excel™ is a spreadsheet program and its data storage capabilities are very limited: no 
data type support, no ability to manage relational databases, etc. This solution allows you to 
manage a simple set of data provided you meet the requirements set by Microsoft. 

The Professional and Expert editions of eMedia CS2 can connect to any database using OLEDB or 
ODBC drivers developed either by the database software publisher, by third-party companies, or 
by enthusiasts under Open Source licenses. 

This highly flexible solution provides access to all the possibilities for storing and managing large 
amounts of data. 

Connection Configuration 
There are several ways to connect to a database in design mode. You may: 

• Use the "Connect to database" command located in 
the "Tools" menu (see on the right), 

• Click the "Connect to batabase" button in 
the toolbar located immediately below the 
menu bar,  

• Use the keyboard shortcut b + n 

In all cases, the Database Connection Wizard window appears: 

This step allows you to select the type 
of database to link to the current card 
template: 

• Microsoft Access™ 

• Microsoft SQL Server™ 

• Oracle™ 

• Microsoft Excel™ 

• Database with an ODBC driver 
(MySQL, SQLLite, etc.)  

• Database with an OLEDB driver 
(MySQL, Active Directory, etc.)  

The last option even allows you to create a database from scratch by specifying all its 
characteristics (tables, fields, etc.). The resulting Microsoft Access™ database will allow you to 
benefit from a real database without requiring Microsoft Access™ to be installed. 

With a Starter or Standard Edition of eMedia CS, you can only connect to a Microsoft Excel™ 
datasheet (XLS or XLSX file). 

However, you can test all connection types by activating the demo mode from the "Help" menu. 
Be careful, however, eMedia CS in demo mode does not print cards correctly by overloading them 
with a "DEMONSTRATION" label. The demo mode can be disabled from the same "Help" menu, 
"Demo Mode". 

Create a Database 

Selecting the last option in the list, "Create a Database," displays the following window: 
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This window allows you to define the table structure to use for the current card template. 

When opened, five fields are already available to store the cardholder's information. 

You may modify this structure as you need by adding new fields at the end of the list or at the 
selected location, changing the type, name, or length of existing fields, or deleting those you don't 
need. You may even reorganize your list. All of these actions can be performed by right-clicking on 
the relevant field. 

Once you click "Next," a database will be created in Microsoft Access™ format and will be 
automatically linked to your card template. 

Warning: This feature requires a Professional or Expert edition of the application. 

 

Database Example 
For the purposes of the rest of this guide, we will use a database provided with this guide. 

It is located on your hard drive in the Samples folder and is named: Utopia RC.xlsx 

Let's connect to this database.  

To do this, open the "Tools" menu and 
select "Database Connection." 

Choose "Microsoft Excel Worksheet 
(MS-Excel 2007-2016)." 

Then click "Next." 

The next page depends on the type of 
database selected: 

• For file-based databases such as MS-Excel™ or MS-Access™, the pathname of the file must be 
provided, 

• For ODBC databases, the ODBC Connection String must be provided (with additional 
information regarding the exact type of database), 

• For advanced databases such as MS-SQL Server™ or Oracle™, the server name and server 
database must be provided, 

• For OLEDB databases, the connection string must be entered. 

Online help can be accessed from any drop-down menu, topic, or Object Property by pressing 
the F1 key on your keyboard. In "Contents" click "Database Connection" / "Create Database". 
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Page 2 

As we've selected a Microsoft Excel™ 
datasheet, the page asks for the name 
of the file containing the data. 

Fill in the input field with the path and 
name of the XLSX file, or click the "…" 
button and select the XLSX file to use 
from the standard dialog box. 

Then click "Next." 

Page 3  

On this page, we're prompted to enter 
additional optional information to 
enable an efficient connection to our 
database, such as authentication 
information if necessary, custom 
timeouts, or other information to 
provide to the database manager. 

Then click "Next." 

Page 4  

This page allows us to specify: 

1. How records should be retrieved 
from the database (see below), 

2. The table name, command text, or 
view name to use, 

3. The recordset type and location of 
the records. 

The record retrieval mode can be 
selected by clicking on the tabs: 

• Table allows you to specify that you want to retrieve all records stored in a database table. For 
Microsoft Excel™, this is a spreadsheet.  

• View can be selected with powerful database managers and allows you to retrieve all records 
selected by a view or a SELECT-type stored procedure.  

• SQL allows you to enter a SELECT SQL statement returning a selection of records from a table 
or from several related tables.  

The list below the mode selection tabs indicates the available elements for the selected mode: list 
of tables, list of views, and SQL statement entry area. 

At the bottom of the dialog box, you'll find options for selecting the recordset type and cursor 
location, which you may need to modify for specific use cases, although the default (Keyset, 
server) is suitable for 95% of those. 

Select the "Members$" spreadsheet and click "Next." 



- 38 - eMedia CS – Quick Start Guide 

© 1999 - 2025 Mediasoft Development SAS All rights reserved 
 228 rue de la Convention – 75015 Paris – France 

3 

Page 5  

This page allows you to authorize 
certain user actions in operating mode: 
modifying records, adding new records, 
and deleting records. 

These rights granted here do not 
override the permissions granted to the 
user specified at login (see page 3: 
Username and Password), which take 
precedence. The three checkboxes 
present here only apply if the 
corresponding rights have been assigned in the table itself and define the presence of 
active/inactive buttons for modifying, adding, or deleting records in eMedia CS. 

The image folder allows you to specify the location where image files are stored when the path is 
not specified in the records. 

Page 6  

This page allows you to specify:  

• Column 1: The field that will be used 
to sort records in alphabetical or 
reverse order.  

• Column 3: The fields that should be 
displayed in the input window in 
operating mode.  

• Column 4: The fields that can be 
modified in operating mode. 

 

Then click on the "Next" button. 

Page 7 

This page allows you to confirm all the choices made previously and to display a preview of the 
selected records: 

 

This record preview window can be accessed at any time in design mode by pressing the F3 
function key. The "Limit to 1000 records" checkbox allows you to display only the first 1000 
records to improve performance. 

Please note that if there is an automatically numbered "record identifier" field, it is strongly 
recommended to uncheck the "Edit" box to avoid any errors when saving the record.. 
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Linking objects and database fields 
The previous steps allowed us to link the map template to a database. Now, in order for the card 
objects to display the data, we need to specify which objects display which fields. 

This process applies to text objects, barcodes, and images. 

Text and Barcode Objects 

Click on the text object we want to associate with a database field. For example, click on the 
"LastName" object. 

In the Properties window, change the Source property and select 
"Database Field." 

In the Field property that appears, click 
the arrow to the right of the box to 
open the drop-down list. 

This list lists all the fields in the 
previously created connection. 

Click on the desired field: LAST_NAME. 

Done! Linking a database field to a map object is as simple as that! 

Image Objects 

The procedure is similar. However, depending on the database type, images may (or may not) be 
saved in tables as large binary objects. While this is possible for Microsoft SQL Server™, Oracle™, 
MySQL™, etc., it is strictly impossible in Microsoft Excel™. In this case, you can save the name of 
the disk file containing the image. 

Click on the holder's picture ("IdPicture" object), then in the 
properties window, click the arrow to the right of the Picture Store 
property to reveal the drop-down list and select "DB field as a path 
to a file". Selecting "DB field as a binary object" performs a binary 
save, as previously indicated, but this is not possible with 
MS-Excel™. 

Click the arrow to the right of the DB Field property and select 
"ID_PICTURE" to specify the name of the field that will contain the 
path to the image file. 

You may now specify how to name the image file when it is 
created by eMedia CS following an acquisition in production mode. 

Click the button to the right of the 
File naming property and select in 
the drop-down list one of the 
following options: 

• Automatic: eMedia CS will assign a name to the file on its own,  

• Manual: A dialog box will prompt the user in operating mode 
to name the file,  

• Formula: A calculation formula will be used to name the file.  

In this case, the Formula property becomes available and allows you 
to enter the calculation formula used to name the image file when it 
is acquired by the user in production mode. 

The default value is "eccs" followed by an automatically generated 
number. The extension depends on the image file type. 
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Exercise 1 

The cardholder's name and photo are now linked to the fields in our database. Let's add the 
following links: 

• The cardholder's first name,  

• The cardholder's category,  

• The validity date.  

If you're successful, congratulations, go to exercise 2! Otherwise, continue below. 

1. Click on the "FirstName" object that should contain the cardholder's first name to select it, and 
then change the Source property to "Database field". Open the Field property drop-down list 
and select "FIRST_NAME". 

2. Click on the "Category" object, the yellow text above the photo, to select it, and then change 
the Source property to "Database field". Open the Field property drop-down list and select 
"CATEGORY". 

3. Click on the "Start_Date" object located below the card to select it, and then change the Source 
property to "Database field". Open the Field property drop-down list and select "START_DATE". 

Exercise 2 

If you switch to operating mode, you'll notice a strange phenomenon: the presence of two 
unexpected input fields in the window on the right: 

 

These two input fields are due to the presence of database fields unrelated to card objects. When 
the input window appears, it first lists all editable card objects, whether or not they are linked to 
database fields, then displays the unlinked database fields, labeled with the field name. 

The goal of this exercise: to create labels those are a little more understandable for the average 
person, such as "Number of printouts" and "Last printed on". 

If you've done it, congratulations! Continue to the next paragraph. Otherwise, continue reading. 

Solution 

1. Create two new objects. Place them outside the card, like the "Start_date" object.  

2. Change their Source property to "Database Field" and set their Field property to 
"PRINT_COUNT" and "PRINT_DATE" respectively.  

3. Finally, change their Text, Order, and Tooltip properties in the Caption category to values that 
are easier for humans to read.  
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Let's go further with the database choice 
The "Database choice" Source allows the user in operating mode to choose a value from a list, 
with two additional, very useful options: 

1. The list of choices will be defined in a secondary table of the database, 

2. The choice made will be saved in a field of the main table. 

Let's take our card as an example: we want each card to display the cardholder's category from a 
predefined list: manager, coach, supporter, or age group. And of course, this choice can be made 
from a list without having to retype the category for each card. 

This is what we will detail below. 

The database choice also allows you to track relationships between two tables. It is possible to 
save a secondary value from another field in the main table field, not the information selected 
from the list. Explanations using the "Database.mdb" database, included among the examples 
provided with the software, in the "School/Files" folder. 

This database contains, among other things, a table named "Grade". In this 
table with 5 records, each has a grade name ("Grade" field) and a number 
("N°" field): 

Still in this database, another table named "Main" contains 
the list of students. 

For each student, we have a "Grade" field containing not the 
Grade name, but its number. This number is the one 
appearing next to the grade name in the "Grade" table. 

For example, student Jonathan Palo is in Grade number 2, meaning 2nd Grade class. 

This technique of referencing codes located in another table allows the creation of "relational" 
databases, meaning that the data maintains relationships between them across different tables. 

What are the benefits of this technique? 

1. Compactness. A number uses less storage space than text. When dealing with huge databases, 
storing codes saves valuable space. 

2. Consistency. No matter which second-grade student is considered, their grade number will 
always be identical, no more uppercase or lowercase letters or typos. 

3. Speed of modification. If tomorrow a change is decided to reform grade names, there will be 
no need to modify all the records; just changing the labels in the Grade table will be sufficient. 

 

Let's define our "database choice" field. 

We will now modify our template so that the cardholder's category (the yellow text above the 
photograph) is of this type and allows selection from a list. 

To do this, we created another sheet in our Excel workbook containing a column with a title and 
possible values for the CATEGORY field: Manager, Coach, Supporter, etc. 

For simplicity, we didn't create a field to establish a relationship 
between the tables. 

Let's select the "Category" object and then change its Source 
property to "Database Choice": 

Now click on the button on the right of the DB choice property, the 
following window appears: 

The "Database Choice" source is only available in the Professional and Expert editions of 
eMedia CS2, or in demo mode. 
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Database choice window 

• Storage field defines the name of the field in the main table where the value selected by the 
user in operating mode should be stored. The button on the right allows you to select the field.  

• Linked table defines the name of the table containing the various choices offered to the user 
in operating mode. The button on the right displays the list of database tables.  

• Linked field specifies the name of the field in the linked table containing the value to be stored 
in the main table. The button on the right allows you to select the field.  

• Displayed text field selects the name of the field in the linked table containing the values to be 
displayed in the choice list. The button on the right allows you to select the field name.  

Below these four input fields, a text summarizes the choices made. 

In our example, the list presented to the user will be all the values in the displayed text field, 
namely the CATEGORY field of the "Categories" table. When the user selects a value, the contents 
of the CATEGORY field in the "Categories" table will be inserted into the CATEGORY field in the 
main table. 

When browsing, the value of the CATEGORY field in the main table will be searched for in the 
linked field in the "Categories" table, and once found, the value of the displayed text field in the 
"Categories" table will be shown on the card. 

In the school example, we would specify: 

• Storage field: Class (from the main table)  

• Linked table: Class (table name, not field)  

• Linked field: N° 

• Displayed text field: Class (from the Class table)  

Thus, when creating the record, the user in operating mode will scroll through the list, which will 
contain all the values in the Class field of the "Class" table, i.e. 1st Grade, 2nd Grade, 3rd Grade, 
4th Grade and 5th Grade. The user will choose one of these options. When selecting 2nd Grade 
for instance, the value in the "Class" table's N° field will be copied to the "Class" field in the main 
table, i.e., the value 2. 

When navigating to the record, eMedia CS2 reads the value in the "Class" field in the main table, 
finds 2, and looks for this value in the "Class" table's N° field. It finds this number in the second 
record and displays the contents of the corresponding displayed text field, i.e., 2nd Grade. 
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Always further, always higher 
Could we imagine even more powerful things, such as displaying images based on a field value, 
changing the colors of text on the card based on information stored in the database, or even 
creating portrait or landscape cards based on other information? 

Yes, absolutely. 

All these operations can be performed either by creating calculation formulas in card objects or 
using scripts developed in VBScript, a simple programming language based on Basic. 

eMedia CS provides the formulas with the values of card objects and the values of database fields 
for the current record. 

eMedia CS provides the scripting language with all the properties of all objects on the card, 
allowing not only the modification of the information displayed by an object, but also its position, 
colors, opacity and visibility, fonts, etc. 

The only limit to the imagination is the designer's capabilities. 

And if these capabilities seem outdated, remember that online help is available, we have 
examples & software development kits available upon request, and a technical support team 
ready to provide any additional assistance. 

THE FINAL TOUCH 
We can lock the card template by assigning it a password, so users cannot modify it. To do this, 
open the "Edit" menu and select the "Set password" command: 

 

Two passwords can be defined, each requiring two entries to prevent typing errors: 

• Enter password needed to open this template prevents unauthorized users from opening 
the template and therefore printing cards based on it.  

• Enter password needed to modify this card template prevents unauthorized users from 
switching to design mode to edit the template.  
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The window is topped with four tabs allowing you to perform searches in several modes. Once 
you have entered your criteria, click the navigation buttons at the bottom of the window to move 
to the first, previous, next, or last record. The button with a printer allows you to print all the 
selected cards. 

The different search methods available are as follows: 

• Field value selects all records for which a 
particular field contains a certain value. 

Select the field to search, then specify the 
value to search for. 

This value can contain one or more 
asterisks, which signify "any sequence of 
characters." 

• SQL Where allows you to enter the 
selection criteria for an SQL query (i.e., what 
follows the WHERE statement of a SELECT). 

This is the most powerful search method, 
but it requires some knowledge of SQL 
syntax. 

• Values allows you to select all records for 
which the contents of a field fall within a 
certain range of values. 

Select the field and then enter the 
minimum and maximum allowed values. 

• Records allows you to select records based 
on their position in the recordset.  

In this example, you want to select records 
number 3, 4 and 5. 

Regardless of the search method used, after entering the search information, you must click one 
of the four navigation buttons located at the bottom of the window to navigate to the first record 
that meets the criteria, the previous, the next, or the last one. 

Only by pressing one of these buttons will the search be initiated and one of the matching records 
selected and displayed by the application. 

If no record matches the criteria, a beep signals that nothing has been found. 

Batch printing 
Batch printing involves printing a set of cards that share a common criterion. 
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You must first use the "Display the contents of the database" window and select the ones you 
want to print, or use the "Search records" window and enter the criteria to select the desired 
records. 

Once you've made your selection, click the button with the printer icon (both windows have this 
button) to bring up a menu, which is identical to the one displayed when you use the "Print" 
command in the "File" menu. 

This menu allows you to tell the software what you want to print/encode for all the selected 
records: front only, back only, print only, encodings, etc. 

Note, however, that printing in large quantities is not necessarily a good idea. While eMedia CS is 
able to print very large volumes with encoding, printing, multiple copies, etc., the printer has its 
own limitations, particularly in terms of feeder capacity, print head cooling, and so on. Several 
small batches are preferable to one large print. 

In any case, if a problem occurs during printing, you always have the option of pressing the 
"Cancel" button displayed on the screen in the print dialog box. Pressing this button even slightly 
stops the printing process. However, wait a few seconds or tens of seconds for the machine to 
finish processing what it cannot interrupt, for the queue to empty, and for the last card to be 
ejected from the printer. 

HAVING ANY TECHNICAL ISSUE? 
Should you have any issue with the software or the printer, your first point of contact will be your 
company's IT department. 

With their help, you can determine whether the issue is hardware-related or related to eMedia CS. 
If the problem is purely hardware-related, contact the manufacturer's customer service 
department. If the issue is software-related, we will be happy to help you. 

Our software is not bug-free, but we do our best to avoid and resolve them when they arise. 

So please feel free to contact us via our website https://www.emedia-cs.com or by email at 
support@emedia-cs.com. 

We don't provide phone support, as email allows for greater flexibility by allowing the sending of 
card templates, database extracts, images, and other information. Thank you for your 
understanding. 
  

https://www.emedia-cs.com
mailto:support@emedia-cs.com
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